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第 1章

Chess-Ant 紹介

Chess problemsをMCTS Solverと Genetic Programmingで解くシミュレーター

chess_ant.pyは deap/examples/gp/ant.pyのコードを改変しています。

1.1 準備

Ubuntuで：

sudo -H -s

apt install python3-pip

pip3 install -r requirements.txt

exit

或いは：

pip3 install chess

pip3 install deap

pip3 install mcts

pip3 install mcts-solver

或いは：

pip3 install chess-ant

• python-chess: a chess library for Python

• DEAP

• MCTS

https://github.com/DEAP/deap/blob/master/examples/gp/ant.py
https://github.com/niklasf/python-chess
https://github.com/DEAP/deap
https://github.com/pbsinclair42/MCTS
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• chess-ant

• chess-classification

• mcts-solver

1.2 使用法

サンプルの chess problemsは pgn/にあります。 Jerryは Forsyth-Edwards Notation (FEN)を貼り付けるのに便利
です。

cd chess-ant/chess-ant/

git checkout -b test-run

python3 chess_ant.py --help

python3 chess_ant.py --auto --fen "7k/1Q6/8/8/5N2/1B6/8/3K4 w - - 0 1"

python3 chess_ant.py -a -c -p "my-pgn" -l1 -n100 -g10 -f "7k/1Q6/8/8/5N2/1B6/8/3K4 w - -␣

↪→0 1"

chess-antを PyPIからインストールした場合：

chess-ant --help

chess-ant -a -n100 -g5 -f "7r/8/8/8/7k/2q5/6P1/6NK b - - 0 1"

このコマンドは誤答を出力するでしょう。時間はかかりますが、以下のコマンドは正しく出力するでしょう。

chess-ant -a -n1000 -g5 -f "7r/8/8/8/7k/2q5/6P1/6NK b - - 0 1"

1.3 Chess-Classification

Version 0.0.1 の genPgn.py はウォルラス演算子を含むので、Python>=3.8 でしか動作しません。Simple Trans-
formersをインストールする前に Pytorchをインストールして下さい。

sudo -H -s

pip3 install pandas

pip3 install simpletransformers

apt install stockfish

pip3 install chess-classification

exit

genPgn --help

genPgn -l 10 -t 1 -p "train-pgn" -f "3qkbnr/8/8/8/8/8/PPPPPPPP/RNBQKBNR w - - 0 1"

(次のページに続く)
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https://github.com/akuroiwa/chess-ant
https://github.com/akuroiwa/chess-classification
https://github.com/akuroiwa/mcts-solver
https://github.com/asdfjkl/jerry
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(前のページからの続き)

cat train-pgn/train-*.pgn >> train-pgn/1.pgn

rm train-pgn/train-*.pgn

genPgn -l 10 -t 1 -p "train-pgn" -f "rnbqkbnr/pppppppp/8/8/8/8/8/3QKBNR w - - 0 1"

cat train-pgn/train-*.pgn >> train-pgn/2.pgn

rm train-pgn/train-*.pgn

genPgn -l 10 -t 1 -p "train-pgn" -f "4k3/pppppppp/8/8/8/8/PPPPPPPP/4K3 w - - 0 1"

cat train-pgn/train-*.pgn >> train-pgn/3.pgn

rm train-pgn/train-*.pgn

importPgn -p "train-pgn"

genPgn -l 10 -t 1 -p "eval-pgn" -f "3qkbnr/8/8/8/8/8/PPPPPPPP/RNBQKBNR w - - 0 1"

cat eval-pgn/train-*.pgn >> eval-pgn/1.pgn

rm eval-pgn/train-*.pgn

genPgn -l 10 -t 1 -p "eval-pgn" -f "rnbqkbnr/pppppppp/8/8/8/8/8/3QKBNR w - - 0 1"

cat eval-pgn/train-*.pgn >> eval-pgn/2.pgn

rm eval-pgn/train-*.pgn

genPgn -l 10 -t 1 -p "eval-pgn" -f "4k3/pppppppp/8/8/8/8/PPPPPPPP/4K3 w - - 0 1"

cat eval-pgn/train-*.pgn >> eval-pgn/3.pgn

rm eval-pgn/train-*.pgn

importPgn -p "eval-pgn"

from chess_classification.chess_classification import ChessClassification

classification = ChessClassification()

保存したモデルの読み込み：

classification = ChessClassification("local-path/your-outputs")

学習か再学習：

classification.train_and_eval("train-pgn/fen.json", "eval-pgn/fen.json")

動作確認：

my_fen = "7r/8/8/8/7k/2q5/6P1/6NK b - - 0 1"

classification.predict_fen(my_fen)

1.3. Chess-Classification 3



Chess-Ant, リリース 0.0.9

予測 ラベル

1-0 2
0-1 1
1/2-1/2 0

chess_ant.pyとの併用：

chess-ant -d -n100 -g5 -f "6rk/4pppp/8/8/3Q4/8/RB2PPPP/R6K w - - 0 1"

保存したモデルの読み込み：

chess-ant -d -n100 -g5 -f "6rk/4pppp/8/8/3Q4/8/RB2PPPP/R6K w - - 0 1" --model-outputs

↪→"local-path/your-outputs"

• Simple Transformers

• Start Locally | PyTorch

• pandas

• Chess-Classification

課題:

• 遅い。

• 低い正答率。

• 並列化。

• 将棋のような他のボードゲームへの対応。

• Universal Chess Interface (UCI)への対応。

• Docstring.

• スパゲティ・コードを茹でる。
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https://github.com/ThilinaRajapakse/simpletransformers
https://pytorch.org/get-started/locally/
https://pandas.pydata.org/
https://github.com/akuroiwa/chess-classification
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abstract
DeepMind が開発した AlphaFold のように、 MCTS は bioinformatics や cheminformatics へ応用でき
る。Chess-Ant では AlphaZero に影響を受けつつも、それとは異なる方法を試す。MCTS Solver と
Genetic Programmingの組み合わせが実用に耐えうるか、その可能性を示すのが目標だ。

2.1 AlphaZeroからの影響

AlphaGo Zeroや AlphaZeroで導入された Polynomial Upper Confidence Tree (PUCT)の変種は事前確率 P (s, a)で

定数 C(s)を補完している。Chess-Antでは従来の Conventional Upper Confidence Tree (UCT)を用い、定数 C(s)

の調整を Genetic Programming (GP)に置き換える*1。1/
√
1から 1/

√
9まで GPは状況に応じて定数 C の値を選

ぶ。定数 C の値により、 chess_ant.pyは積極的に調べたり、消極的な調べ方をする。

AlphaZero's PUCT*2*3*4*5:

at = argmaxa(Q(st, a) + U(st, a))

U(s, a) = C(s)P (s, a)

√
N(s)

1 +N(s, a)

C(s) = log
1 +N(s) + cbase

cbase
+ cinit

*1 Cazenave, Tristan. “Evolving Monte-Carlo Tree Search Algorithms.” (2007).
*2 AlphaZero: Shedding new light on chess, shogi, and Go
*3 Silver, David et al. “A general reinforcement learning algorithm that masters chess, shogi, and Go through self-play.” Science 362 (2018):

1140 - 1144.
*4 Foster, David. (2017). AlphaGo Zero Explained In One Diagram
*5 Tadao Yamaoka’s diary

https://www.semanticscholar.org/paper/Evolving-Monte-Carlo-Tree-Search-Algorithms-Cazenave/336231ec5085098b35c573d885e18c3392e3703d
https://deepmind.com/blog/article/alphazero-shedding-new-light-grand-games-chess-shogi-and-go
https://www.semanticscholar.org/paper/A-general-reinforcement-learning-algorithm-that-and-Silver-Hubert/f9717d29840f4d8f1cc19d1b1e80c5d12ec40608
https://www.semanticscholar.org/paper/A-general-reinforcement-learning-algorithm-that-and-Silver-Hubert/f9717d29840f4d8f1cc19d1b1e80c5d12ec40608
https://medium.com/applied-data-science/alphago-zero-explained-in-one-diagram-365f5abf67e0
https://tadaoyamaoka.hatenablog.com/entry/2018/12/08/191619
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Deep neural network (p, v) = fθ(s)はパラメータ θ により末端のノード sL を評価する：

(p, v) = fθ(sL)

初期化：

N(sL, a) = 0

W (sL, a) = 0

Q(sL, a) = 0

P (sL, a) = pa

更新：

t ≤ L

N(st, at) = N(st, at) + 1

W (st, at) = W (st, at) + v

Q(st, at) =
W (st, at)

N(st, at)

詳細

(s,a) それぞれの state-actionのペア
N(s) 親（ノード）の訪問数

N(s,a) 訪問数

W(s,a) action-valueの合計
Q(s,a) action-valueの平均
P(s,a) sでの aを選択する事前確率
C(s) Exploration（と Exploitation）の割合
p （Deep neural networkにより予測された）手を選ぶ確率のベクトル
v （Deep neural networkにより予測された）スカラー値
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Chess-Ant's UCT*6*7*8*9*10:

at = argmaxa(Q(st, a) + Cgp

√
2lnN(st)

N(st, a)
)

Cgp =



1/
√
1,

1/
√
2,

1/
√
3,

1/
√
4,

1/
√
5, If the previously selected node state is under certain conditions

1/
√
6,

1/
√
7,

1/
√
8,

1/
√
9,

判断する条件は以下の通り：

条件 詳細

if_improvement 前回よりも UCTが増加したら
if_shortcut move_stackが前回よりも短くなったら
if_result 前回の rolloutが勝ちか負けか引き分けか
if_pruning UCTが無限大か無限小か、何れでもないか
if_is_check 前回選ばれた nodeで checkだったか

また、GPは各 generationにおいて、やり直すことができるので、訪問回数による検索初期の UCTの高評価を防
げる。この論文のような効果を得られるかも知れない*11。

2.2 MCTS Solver

MCTS Solver*12*13 の導入により、高速化と誤答を減らす為の枝切りを行う。

論文の擬似コードを大幅に変更している理由は、継承クラスが参照するパッケージのコードの書き方が異なるか

らだ。

*6 Auer, Peter et al. “Finite-time Analysis of the Multiarmed Bandit Problem.”Machine Learning 47 (2004): 235-256.
*7 Kocsis, Levente and Csaba Szepesvari. “Bandit Based Monte-Carlo Planning.” ECML (2006).
*8 Swiechowski, Maciej et al.“Monte Carlo Tree Search: A Review of Recent Modifications and Applications.”ArXiv abs/2103.04931 (2021):

n. pag.
*9 Wikipedia contributors. "Monte Carlo tree search." Wikipedia, The Free Encyclopedia. Wikipedia, The Free Encyclopedia, 18 Oct. 2021.

Web. 25 Dec. 2021.
*10 Wikipedia contributors. "モンテカルロ木探索." Wikipedia. Wikipedia, 8 Oct. 2021. Web. 25 Dec. 2021.
*11 Imagawa, Takahisa and Tomoyuki Kaneko. “Improvement of State’s Value Estimation for Monte Carlo Tree Search.” (2017).
*12 Winands, Mark & Björnsson, Yngvi & Saito, Jahn-Takeshi. (2008). Monte-Carlo Tree Search Solver. 25-36. 10.1007/978-3-540-87608-3_3.
*13 Baier, Hendrik & Winands, Mark. (2015). MCTS-Minimax Hybrids. IEEE Transactions on Computational Intelligence and AI in Games.

7. 167-179. 10.1109/TCIAIG.2014.2366555.
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https://github.com/pbsinclair42/MCTS
https://www.semanticscholar.org/paper/Finite-time-Analysis-of-the-Multiarmed-Bandit-Auer-Cesa-Bianchi/1e1d35136b1bf3b13ef6b53f6039f39d9ee820e3
https://www.semanticscholar.org/paper/Bandit-Based-Monte-Carlo-Planning-Kocsis-Szepesvari/e635d81a617d1239232a9c9a11a196c53dab8240
https://www.semanticscholar.org/paper/Monte-Carlo-Tree-Search%3A-A-Review-of-Recent-and-Swiechowski-Godlewski/ad5fc69f2b092eab4171d1e87c59ef7992dfdc6e
https://www.semanticscholar.org/paper/Monte-Carlo-Tree-Search%3A-A-Review-of-Recent-and-Swiechowski-Godlewski/ad5fc69f2b092eab4171d1e87c59ef7992dfdc6e
https://en.wikipedia.org/w/index.php?title=Monte_Carlo_tree_search&oldid=1050627850
https://en.wikipedia.org/w/index.php?title=Monte_Carlo_tree_search&oldid=1050627850
https://ja.wikipedia.org/w/index.php?title=%E3%83%A2%E3%83%B3%E3%83%86%E3%82%AB%E3%83%AB%E3%83%AD%E6%9C%A8%E6%8E%A2%E7%B4%A2&oldid=85943688
https://www.semanticscholar.org/paper/Improvement-of-State%E2%80%99s-Value-Estimation-for-Monte-Imagawa-Kaneko/1b45c6e02944e2f4ec2dbc77083e8cc4eb7c9e8a
https://www.researchgate.net/publication/220962507_Monte-Carlo_Tree_Search_Solver
https://dke.maastrichtuniversity.nl/m.winands/documents/mcts-minimax_hybrids_final.pdf
https://dke.maastrichtuniversity.nl/m.winands/documents/mcts-minimax_hybrids_final.pdf
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さらに、Pythonでは gotoが無いので、余計なコードがある。擬似コードではMCTS Solver内部で全て完結する
が、 chess_ant.pyでは _executeRound()に分けて書いてある。 mctsSolver()内で rolloutを実行し、枝切り
などの処理をし、rolloutと同様に rewardを出力し、 backpropogate()に入力する。

Negamaxと同様にMCTS solverも再帰関数であり、停止条件が必要だ。

2.3 並列処理

mcts-solver 0.0.5から、OpenAIの ChatGPTと Google Bardの助けを得てコードを変更し、並列処理*14*15 を行

えるようにした。Tree並列化は root並列化に比べて、locksを用いなければならないので作業が難しい。これらの
変更が正しく動作しているか確証が持てないので、今後大幅に変更するかも知れない。Context managersは便利だ
けれども、使用法を誤ると大変なことになる。

2.4 変更履歴

chess-classificationと chem-classificationは同じアルゴリズムを用いているので、同時期に同じ変更を

施している。

chess-classification 0.0.4で fenを tokenに区切ってデータセットを作成するようにした。その fenは 1文字
ずつではなく、一列ごとに区切ってある。

chess-ant 0.0.5 まで UCB1 の数式に誤りがあったので math.sqrt(2) を追加し、訂正した。mcts の作者が、

mcts.py内で explorationConstant = 1 / math.sqrt(2)を初期値としたのは、math.sqrt(2)を打ち消すた

めと思われる。新たに selectNodeEphemeralConstantという terminalを chess-ant 0.0.6で追加し、ephemeral
constantの代替とした。

Issues #658によると、Deapは Python 3.10で動作せず、version 3.11で動作する。

~/.bashrc或いは ~/.bash_aliasesで：

# Python version

alias python3='/usr/bin/python3.11'

続いて sourceを実行する：

source ~/.bash_aliases

別の方法として、 update-alternativesがある。

*14 Chaslot, Guillaume & Winands, Mark & Herik, H.. (2008). Parallel Monte-Carlo Tree Search. 60-71. 10.1007/978-3-540-87608-3_6.
*15 Soejima, Yusuke & Kishimoto, Akihiro & Watanabe, Osamu. (2009). Root Parallelization of Monte Carlo Tree Search and Its Effectiveness

in Computer Go.
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https://stackoverflow.com/questions/18386616/can-i-acquire-multiprocessings-lock-in-a-with-statement
https://github.com/DEAP/deap/issues/658
https://dke.maastrichtuniversity.nl/m.winands/documents/multithreadedMCTS2.pdf
http://id.nii.ac.jp/1001/00097696/
http://id.nii.ac.jp/1001/00097696/
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update-alternatives --install /usr/bin/python3 python3 /usr/bin/python3.10 2

update-alternatives --install /usr/bin/python3 python3 /usr/bin/python3.11 1

update-alternatives --config python3

python3 --version

最優先に設定した元のヴァージョンに戻すには：

update-alternatives --auto python3

2022年 12月現在、gnome-terminalは Ubuntu 22.04.1 LTSの Python 3.11では起動しないことを覚えておいて欲
しい。

より一般的な方法は venvを用いる：

sudo apt install python3.11-venv

python3.11 -m venv ~/.venv3.11

source ~/.venv3.11/bin/activate

which pip3

終了するには：

deactivate

chess-classification 0.0.5から、保存したモデルの読み込みが出来る。

学習時間を短縮するために、*16 checkpointが google/electra-small-discriminator*17 の electra modelに変更した。

私が用意した pgnファイルは chess problemsと言うよりも寧ろ tactics*18*19 に近いので、データセットは tacticsか
ら作成する方が効率が良い。正解率を高めるためには、モデルの学習とモデルの評価にそれぞれ 300行以上の pgn
データが必要だ。

2.5 開発予定

課題: 別のプロジェクトとして FENの勝敗評価に Natural Language Processing (NLP)用の deep learning*20*21 を

導入する。

*16 Rajapakse, Thilina. (2020). Battle of the Transformers: ELECTRA, BERT, RoBERTa, or XLNet
*17 ELECTRA: Pre-training Text Encoders as Discriminators Rather Than Generators
*18 Download tactics database
*19 Gorgonian's Chess Site
*20 Savransky, Dmitriy. (2020). How to Use GPT-2 for Custom Data Generation. INTERSOG Inc.
*21 Noever, David et al. “The Chess Transformer: Mastering Play using Generative Language Models.” arXiv: Artificial Intelligence (2020):

n. pag.
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https://towardsdatascience.com/battle-of-the-transformers-electra-bert-roberta-or-xlnet-40607e97aba3
https://huggingface.co/google/electra-small-discriminator
https://lichess.org/forum/lichess-feedback/download-tactics-database
http://gorgonian.weebly.com/
https://intersog.com/blog/the-gpt-2-usage-for-custom-data-generation-by-example-playing-chess/
https://arxiv.org/pdf/2008.04057.pdf
https://arxiv.org/pdf/2008.04057.pdf
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genPgn.pyは stockfishで自動対局をし、PGN filesを出力する。ちなみに、Version 0.0.1の genPgn.pyはウォル

ラス演算子を含むので、Python>=3.8でしか動作しない。 importPgn.pyは PGN filesからデータセットを作成す
る。 chess_classification.py は Simple Transformers による学習済みモデルを生成する。この学習済みモデ
ルを用いて、AlphaZeroのように chess_ant.pyの rolloutの代用とする予定だ。
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https://www.researchgate.net/publication/221009242_Learning_Recursive_Functions_with_Object_Oriented_Genetic_Programming
https://pdfs.semanticscholar.org/b0bc/b2e8c96c750c8cae70ad20c675023f314191.pdf
https://www.youtube.com/channel/UCbNpPBMvCHr-TeJkkezog7Q
https://www.antwiki.org/wiki/Welcome_to_AntWiki
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py-chessboardjs

pywebviewと chessboard.jsを利用した Chess GUIです。主要ファイルは start.py, js/my-script.jsと index.

htmlです。

Chess-Antは遅すぎてチェス・エンジンとして機能しません。更に、チェス・エンジンを呼び出す際の不具合もあ
ります。実験目的として pgnファイルを読み込み、chess problemを解かすことは出来ます。

3.1 インストール方法

まず pywebviewと PyGObjectのマニュアルを読み、作業前に依存パッケージをインストールして下さい。

If you are Ubuntu user:

sudo apt install python3-venv

python3.11 -m venv ~/.venv3.11

source ~/.venv3.11/bin/activate

which pip

pip install py-chessboardjs[gtk]

If you want to install it on local repository:

cd py-chessboardjs

pip install .[gtk]

QT user:

pip install py-chessboardjs[qt]

CEF user:

https://pywebview.flowrl.com/
https://pygobject.readthedocs.io/en/latest/
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pip install py-chessboardjs[cef]

Install your favorite UCI engine:

sudo apt install stockfish

3.2 使用法

py-chessboardjs-gtk

py-chessboardjs-qt

py-chessboardjs-cef

3.3 関連リンク

• pywebview

• chessboard.js

• chess.js

• Bootstrap

14 第 3 章 py-chessboardjs

https://pywebview.flowrl.com/
https://chessboardjs.com/
https://github.com/jhlywa/chess.js
https://getbootstrap.com/
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第 4章

Chem-Ant 紹介

MCTS Solverと Genetic Programmingにより、目標分子に似た分子を出力する為の材料候補を選ぶ。

similarity_ant.pyは deap/examples/gp/ant.pyのコードを改変しています。

4.1 準備

Ubuntuで：

sudo -H -s

apt install python3-pip

pip3 install -r requirements.txt

exit

或いは：

pip3 install deap

pip3 install mcts

pip3 install rdkit

pip3 install global_chem_extensions

pip3 install mcts-solver

或いは：

pip3 install chem-ant

chem-antを chem-classificationと共に使いたければ：

pip3 install simpletransformers

https://github.com/DEAP/deap/blob/master/examples/gp/ant.py
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或いは：

pip3 install chem-classification

• DEAP

• MCTS

• RDKit

• rdkit-pypi

• Global-Chem

• chem-ant

• chem-classification

• mcts-solver

4.2 使用法

初期値では、 smiles.csvから分子のリストを得る。ターゲットは Nirmatrelvirだ。そのリストからフラグメント
の材料として最適なものが選ばれる。出力される csvファイルには、mcts実行途中で出来た分子も含まれる。csv
ファイルを smiles listとして再利用したければ、 --selectオプションを追加する。インストールせずに直接実行
したければ、 python3 similarity_mcts.py --helpとする。

similarity-mcts --help

similarity-mcts -i -l1 -e3 -r10 -b500 -p train_smiles

similarity-mcts -i -l1 -e3 -r10 -b500 -p eval_smiles

ターゲットを指定して実行したければ：

similarity-mcts -i -l1 -e3 -r10 -b500 -p train_smiles -t

↪→"CC(C)(C)C(NC(=O)C(F)(F)F)C(=O)N1CC2C(C1C1CCNC1=O)C2(C)C"

similarity-mcts -i -l1 -e3 -r10 -b500 -p eval_smiles -t

↪→"CC(C)(C)C(NC(=O)C(F)(F)F)C(=O)N1CC2C(C1C1CCNC1=O)C2(C)C"

similarity-mcts は、smiles のリストからフラグメントの材料と成り得る候補を選び出力する。mcts を実行せ
ず、単にその smiles listからターゲットに似た分子を出力したければ：

similarity-genMols --help

similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C

↪→#N)C" -m "CC1=CC=CC=C1C(C)C" "Cc1ccccc1CC(C#N)NC1CCNC1=O" -f "gen2.csv"
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https://github.com/DEAP/deap
https://github.com/pbsinclair42/MCTS
https://www.rdkit.org/
https://pypi.org/project/rdkit-pypi/
https://github.com/Sulstice/global-chem
https://github.com/akuroiwa/chem-ant
https://github.com/akuroiwa/chem-classification
https://github.com/akuroiwa/mcts-solver


Chess-Ant, リリース 0.0.9

4.3 Chem-Classification

chem-classification用に json formatのデータセットを出力する：

importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C"␣

↪→-p "train_smiles"

importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C"␣

↪→-p "eval_smiles"

regression model用のデータセットを出力したければ：

importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C"␣

↪→-p "train_smiles" -r

importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C"␣

↪→-p "eval_smiles" -r

classification modelを訓練し、Nirmatrelvirと YH-53の類似性を予測する：

from chem_classification.similarity_classification import SimilarityClassification

s = SimilarityClassification()

s.train_and_eval("train_smiles/smiles.json", "eval_smiles/smiles.json")

s.predict_smiles_pair([

↪→"CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C",

↪→"CC(C)CC(C(=O)NC(CC1CCNC1=O)C(=O)C2=NC3=CC=CC=C3S2)NC(=O)C4=CC5=C(N4)C=CC=C5OC"])

保存したモデルの読み込み：

s = SimilarityClassification("local-path/your-outputs")

regression modelを訓練し、 Nirmatrelvirと YH-53の類似性を予測する：

from chem_classification.similarity_classification import SimilarityRegression

s = SimilarityRegression()

s.train_and_eval("train_smiles/smiles.json", "eval_smiles/smiles.json")

s.predict_smiles_pair([

↪→"CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C",

↪→"CC(C)CC(C(=O)NC(CC1CCNC1=O)C(=O)C2=NC3=CC=CC=C3S2)NC(=O)C4=CC5=C(N4)C=CC=C5OC"])

similarity-mctsにより出力された json filesにより訓練された、もう一つの regression modelは、材料候補から
ターゲット分子との類似性を予測する。そして、 similarity-antと連携できる：

4.3. Chem-Classification 17
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similarity-mcts -i -l2 -e3 -r10 -b100 -p "train_smiles" -f "smiles.json" -j

similarity-mcts -i -l2 -e3 -r10 -b100 -p "eval_smiles" -f "smiles.json" -j

注釈: chem-ant 0.0.7から、分子のフラグメントをトークンとしてデータセットを作成するように変更したので、
2つの regression modelsの差は無くなった。

chem-classificationと similarity-antの連携（現状では機能せず）：

similarity-ant -n20 -g5 -b 1 -p gen_smiles -d -o "local-path/your-outputs"

Regression modelの chem-classificationと similarity-antの連携：

similarity-ant -n20 -g5 -b 1 -p gen_smiles -r -o "local-path/your-outputs"

18 第 4 章 Chem-Ant 紹介
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第 5章

Chem-Ant 論文

author
Akihiro Kuroiwa

date
2022/07/08

abstract
2019 年に chess-ant を書き始めたのだが、最初は minimax にこだわり、遅々として作業は進まな
かった。2020年にクルーズ船ダイヤモンド・プリンセス号の COVID-19集団感染があり、いよいよパ
ンデミックが注目され始めた頃、 chess-antのアルゴリズムを治療薬の開発に役立てようと思い立っ

た。その後、MCTS solverの論文を読み、性能が向上した。同時に cheminformaticsのソフトウェアの
使い方も身についていった。SARS-CoV-2のパンデミックが収束した後も、次なるパンデミックが待
ち構えている。我々の技能で社会に貢献しよう。

5.1 UCSF Chimera

私の古いラップトップ Fujitsu LIFEBOOK AH42/Cに UCSF ChimeraXをインストールしようとしたら、次のよう
なエラーが表示された：

ERROR: ChimeraX requires OpenGL graphics version 3.3.

Your computer graphics driver provided version 2.1

Try updating your graphics driver.

従って、この実験では、 UCSF Chimeraを用いる。その利点は、 binding siteと呼ばれる結合部位をマウスで指定
できることにある。

chmod u+x chimera-alpha-linux_x86_64.bin

./chimera-alpha-linux_x86_64.bin

https://www.cgl.ucsf.edu/chimerax/
https://www.rbvi.ucsf.edu/chimera/
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Ubuntuの ~/.profileで：

if [ -d "$HOME/.local/bin" ] ; then

PATH="$HOME/.local/bin:$PATH"

fi

私の場合、インストールする場所は 2箇所に分かれる：

~/.local/bin/

~/.local/UCSF-Chimera64-2022-05-18/

ターミナルを開いてコマンドラインで chimeraを実行するか、デスクトップに出来たアイコンを右クリックし、

実行権限を与え、ダブルクリックする。

実験に先立ち、最新リリースの AutoDock Vina installer from GitHubを入手し、マニュアルに沿いインストールす
る。バイナリーファイル（実行ファイル）の在り処は、次のコマンドで確認できる：

cd ~/.local/bin/

ln -s vina_1.2.3_linux_x86_64 vina

which vina

動作検証をするために、次のように実験を進める：

1. ターゲット分子 Nirmatrelvirのみをフラグメントにし、分子を幾つか出力する。

2. ターゲット分子を含む材料候補を similarity-mctsで選び、分子を幾つか出力する。

3. 両者の差集合を得る。

similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C

↪→#N)C" -m "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -b70␣

↪→-p "gen_smiles" -f "gen1-1.csv"

similarity-mcts -l2 -e3 -r10 -b100 -p "gen_smiles" -f "gen1-2.csv"

実行後、次のように表示されただろう：

Material candidates: {'CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C

↪→#N)C', 'CCCC1=NC(=C(N1CC2=CC=C(C=C2)C3=CC=CC=C3C4=NNN=N4)C(=O)O)C(C)(C)O'}

similarity-genMolsを実行する際に気をつけることがある。Pythonではシングルクォートとダブルクォートを区別
しないが、 bashや dashでは区別する。更に、コマンドラインでカンマは不要だ：

similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C

↪→#N)C" -m "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C"

(次のページに続く)
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https://github.com/ccsb-scripps/AutoDock-Vina
https://stackoverflow.com/questions/18180763/set-difference-for-pandas
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(前のページからの続き)

↪→"CCCC1=NC(=C(N1CC2=CC=C(C=C2)C3=CC=CC=C3C4=NNN=N4)C(=O)O)C(C)(C)O" -b100 -f gen1-2.csv

similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C

↪→#N)C" -m "CCCC1=NC(=C(N1CC2=CC=C(C=C2)C3=CC=CC=C3C4=NNN=N4)C(=O)O)C(C)(C)O" -b100 -f␣

↪→gen1-3.csv

import pandas as pd

df1_1 = pd.read_csv("gen_smiles/gen1-1.csv", header=0, index_col=0)

df1_2 = pd.read_csv("gen_smiles/gen1-2.csv", header=0, index_col=0)

df1_3 = pd.read_csv("gen_smiles/gen1-3.csv", header=0, index_col=0)

df1_4 = pd.concat([df1_1, df1_1, df1_2, df1_3, df1_3], axis=0)

df1_4.drop_duplicates(subset="smiles", keep=False, inplace=True)

df1_4.sort_values(["lipinski", "dice_similarity"], inplace=True, ascending=False)

df1_4.reset_index(drop=True).to_csv("gen_smiles/gen1-4.csv")

Ligand fileを Open Babelで作成する。gen3.csvを開き、 similarity-mctsで得た高得点の分子の smilesを指
定しよう。水素原子を付加し、部分電荷を割り当てるのを忘れないように。Ubuntuで：

sudo apt install openbabel

obabel -L

obabel -L charges

obabel -h -c -ican -:"CCCC1C2C(CN1C(=O)C1C3C(CN1C(=O)C(F)(F)F)C3(C)C)C2(C)C" -opdbqt -O␣

↪→ligand.pdbqt --gen3D --partialcharge gasteiger

UCSF Chimeraに戻ろう。上記のファイルを開き、以下のようにメニューを辿る：

1. File → Fetch Structure by ID → PDB(mmCIF) → 7tll

2. File → Open → ligand.pdbqt → file type PDB

3. Tools → Surface/Binding Analysis → AutoDock Vina

我々の Output fileは allだ。Receptor と Ligand を指定しよう。Resize search volume usingをマウス操作の為に
チェックする。上記のコマンドで得た vinaのパスを Executable locationに書く。

私の場合、 binding siteをマウスで指定すると、Presetsメニューで切り替えるまで枠が表示されない。実験結果を
後程、再確認したければ all.receptor.pdbを開き、次のようにする：

1. Tools → Surface/Binding Analysis → ViewDock → all.pdbqt

2. Move → Play
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5.2 AutoDock Vina

UCSF Chimeraにより出力された receptor fileを再利用し、コマンドラインであなたが独自に作成した ligand file
を実験したいだろう。設定ファイル conf.txtを用意しよう：

receptor = all.receptor.pdbqt

ligand = ligand.pdbqt

out = all.pdbqt

center_x = -2.68714

center_y = -1.23572

center_z = 13.8821

size_x = 25.747

size_y = 22.6627

size_z = 22.1881

similarity-mctsは今回は Catechinと謎めいた分子 Gnididin*1 を選んだ：

similarity-mcts -l2 -e3 -r10 -b100 -p "gen_smiles" -f "gen2-2.csv"

Material candidates: {'C1C(C(OC2=CC(=CC(=C21)O)O)C3=CC(=C(C=C3)O)O)O',

↪→'CCCCCC=CC=CC(=O)OC1C(C23C4C=C(C(=O)C4(C(C5(C(C2C6C1(OC(O6)(O3)C7=CC=CC=C7)C(=C)C)O5)CO)O)O)C)C

↪→'}

gen2-2.csv:

,smiles,dice_similarity,lipinski

0,C=C(C)C12OC3(CO)OC1C1C4OC4(CO)C(O)C4(O)C(=O)C(C)=CC4C1(O3)C(C)C2CO,0.19672131147540983,

↪→1.0

残念ながら、この分子は Gnididinのみで生成されたフラグメントにより出来る。

obabel -h -c -ican -:"C=C(C)C12OC3(CO)OC1C1C4OC4(CO)C(O)C4(O)C(=O)C(C)=CC4C1(O3)C(C)C2CO

↪→" -opdbqt -O ligand.pdbqt --gen3D --partialcharge gasteiger

AutoDock Vinaを実行する：

*1 Sisakht, M., Mahmoodzadeh, A., & Darabian, M. (2021). Plant-derived chemicals as potential inhibitors of SARS-CoV-2 main protease
(6LU7), a virtual screening study. Phytotherapy research : PTR, 35(6), 3262–3274. https://doi.org/10.1002/ptr.7041
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vina --config conf.txt

mode | affinity | dist from best mode

| (kcal/mol) | rmsd l.b.| rmsd u.b.

-----+------------+----------+----------

1 -8.765 0 0

2 -8.31 1.82 6.828

3 -8.252 2.441 4.152

4 -8.086 1.664 7.041

5 -7.85 2.301 7.148

6 -7.825 1.726 6.693

7 -7.797 3.008 6.184

8 -7.412 2.183 7.011

9 -7.339 2.426 4.168

5.3 鋳型と鋳物

参照した論文に書かれているアミノ酸相互作用は*2 PDB ID: 6LU7に基づく。一方、我々の実験は the SARS-CoV-2
Mpro Omicron P132Hに基づいており、 PDB ID: 7TLLを使用する。Active site amino acidの冒頭 3文字はアミノ
酸の略号で、残りは配列上の位置を示す。UCSF Chimeraで確認しよう：

1. Presets → Interactive 1 (ribbons)と chimeraのメニューで辿る。

2. カーソルを binding site上の receptorの active site amino acidに合わせると、その位置が表示される。

3. chimeraで Tools → Sequence → Sequenceを辿り、ヌクレオチドやアミノ酸の sequence alignmentを表示
し、 fast formatで保存する。

4. 活性部位のアミノ酸を確認したいならば、配列上のその場所で右クリックする。

鋳型から鋳物を鋳造すれば、元の鋳型に合うはずだ。私が smiles.csv*3 にアミノ酸とヌクレオチドを追加した理

由でもある。Docking simulationにおける binding siteと ligandの関係も同様だと言えるかどうか、以下の方法で
実験する：

1. 該当箇所を rdkitで smilesに変換する。範囲は Phe140から Glu166迄だ。

2. その smiles文字列は長過ぎるので、 fragmentsに分解し、幾つかの分子に出力する。

*2 SAMANT, L., & Javle, V. (2020). Comparative Docking Analysis of Rational Drugs Against COVID-19 Main Protease. ChemRxiv.
doi:10.26434/chemrxiv.12136002.v1 This content is a preprint and has not been peer-reviewed.

*3 PubChem

5.3. 鋳型と鋳物 23

https://www.rcsb.org/structure/6lu7
https://www.rcsb.org/structure/7tll
https://chemrxiv.org/engage/chemrxiv/article-details/60c749fd702a9b828b18b20c
https://chemrxiv.org/engage/chemrxiv/article-details/60c749fd702a9b828b18b20c
https://pubchem.ncbi.nlm.nih.gov/


Chess-Ant, リリース 0.0.9

from rdkit import Chem

from rdkit.Chem import BRICS

Chem.MolToSmiles(Chem.MolFromFASTA("FLNGSCGSVGFNIDYDCVSFCYMHHME"))

smiles =

↪→'CC[C@H](C)[C@H](NC(=O)[C@H](CC(N)=O)NC(=O)[C@H](Cc1ccccc1)NC(=O)CNC(=O)[C@@H](NC(=O)[C@H](CO)NC(=O)CNC(=O)[C@H](CS)NC(=O)[C@H](CO)NC(=O)CNC(=O)[C@H](CC(N)=O)NC(=O)[C@H](CC(C)C)NC(=O)[C@@H](N)Cc1ccccc1)C(C)C)C(=O)N[C@@H](CC(=O)O)C(=O)N[C@@H](Cc1ccc(O)cc1)C(=O)N[C@@H](CC(=O)O)C(=O)N[C@@H](CS)C(=O)N[C@H](C(=O)N[C@@H](CO)C(=O)N[C@@H](Cc1ccccc1)C(=O)N[C@@H](CS)C(=O)N[C@@H](Cc1ccc(O)cc1)C(=O)N[C@@H](CCSC)C(=O)N[C@@H](Cc1c[nH]cn1)C(=O)N[C@@H](Cc1c[nH]cn1)C(=O)N[C@@H](CCSC)C(=O)N[C@@H](CCC(=O)O)C(=O)O)C(C)C

↪→'

allfrags = set()

allfrags.update(BRICS.BRICSDecompose(Chem.MolFromSmiles(smiles), returnMols=True))

builder = BRICS.BRICSBuild(allfrags)

generated_smiles = []

for i in range(30):

mol = next(builder)

mol.UpdatePropertyCache(strict=True)

generated_smiles.append(Chem.MolToSmiles(mol))

generated_smiles

['CSCC[C@H](SC)C(=O)N[C@@H](CCC(=O)O)C(=O)O', 'CSCC[C@H](SC)C(=O)Nc1c[nH]cn1',

↪→'CSCC[C@H](SC)C(=O)Nc1ccc(O)cc1', 'CSCC[C@H](SC)C(=O)Nc1ccccc1',

↪→'CS[C@@H](CC(C)C)C(=O)Nc1ccc(O)cc1',

↪→'CC(C)C[C@H](N[C@@H](CCC(=O)O)C(=O)O)C(=O)Nc1ccc(O)cc1',

'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)Nc1ccc(O)cc1', 'CC(C)C[C@H](Nc1ccccc1)C(=O)Nc1ccc(O)cc1',

'CC(C)C[C@H](Nc1c[nH]cn1)C(=O)Nc1ccc(O)cc1', 'CS[C@@H](CC(C)C)C(=O)Nc1c[nH]cn1',

↪→'CS[C@@H](CC(C)C)C(=O)Nc1ccccc1', 'CS[C@@H](CC(C)C)C(=O)N[C@@H](CCC(=O)O)C(=O)O',

↪→'CS[C@@H](CC(=O)O)C(=O)NC(=O)[C@H](CC(C)C)SC',

↪→'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](SC)C(C)C',

'CS[C@@H](CC(N)=O)C(=O)NC(=O)[C@H](CC(C)C)SC', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@H](CS)SC',

'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](N)Cc1c[nH]cn1',

↪→'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](N)Cc1ccc(O)cc1',

'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](N)Cc1ccccc1', 'CS[C@@H](CO)C(=O)NC(=O)[C@H](CC(C)C)SC

↪→', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@H](CC(C)C)SC',

↪→'CC[C@H](C)[C@H](SC)C(=O)NC(=O)[C@H](CC(C)C)SC', 'CSCC(=O)NC(=O)[C@H](CC(C)C)SC',

↪→'CC(C)C[C@H](N[C@@H](CCC(=O)O)C(=O)O)C(=O)Nc1ccccc1',

↪→'CC(C)C[C@H](Nc1c[nH]cn1)C(=O)Nc1ccccc1', 'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)Nc1ccccc1',

↪→'CC(C)C[C@H](Nc1ccccc1)C(=O)Nc1ccccc1',

↪→'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O',

↪→'CC(C)C[C@H](Nc1ccccc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O',

↪→'CC(C)C[C@H](N[C@@H](CCC(=O)O)C(=O)O)C(=O)N[C@@H](CCC(=O)O)C(=O)O']

1. 出力された分子から、ドッキング・シミュレーションで好成績となった分子を選ぶ。勿論、選択肢の中での
好成績だが。
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2. その分子をターゲットに similarity-mctsを動かす。

obabel -h -c -ican -:"CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O" -opdbqt -O␣

↪→ligand.pdbqt --gen3D --partialcharge gasteiger

vina --config conf.txt

mode | affinity | dist from best mode

| (kcal/mol) | rmsd l.b.| rmsd u.b.

-----+------------+----------+----------

1 -7.192 0 0

2 -7.014 2.837 4.843

3 -7.002 1.339 2.292

4 -7.001 2.143 4.417

5 -6.894 1.303 2.67

6 -6.759 2.539 6.62

7 -6.578 2.329 7.121

8 -6.547 3.004 7.767

9 -6.51 1.3 2.908

similarity-mcts -i -l2 -e3 -r10 -b100 -p "gen_smiles" -f "gen3-2.csv" -t

↪→"CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O"

Material candidates: {'CC1CCC2C(C(OC3C24C1CCC(O3)(OO4)C)OC)C', 'C(CCN)CC(C(=O)O)N',

↪→'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O'}

,smiles,dice_similarity,lipinski

0,CCNC1CCNC1=O,0.5454545454545454,1.0

1,CC(Nc1ccccc1)C(=O)Oc1ccccc1,0.5269607843137255,1.0

2,COC(=O)[C@H](CC(C)C)Nc1ccc(O)cc1,0.5084427767354597,1.0

3,CC(C)C(=O)OC(=O)C(C)C,0.5078125,1.0

4,O=C1NCCC1Nc1ccc(F)cc1,0.5066162570888468,1.0

5,COC(=O)[C@H](CC(C)C)OC,0.5040983606557377,1.0

6,C(c1nn[nH]n1)c1nn[nH]n1,0.4921875,1.0

7,CCOc1nn[nH]n1,0.4765625,1.0

8,COc1ccc(O)cc1,0.46875,1.0

9,CO[C@@H](CCC(=O)O)C(=O)O,0.4609053497942387,1.0

10,CC(C(=O)N1Cc2ccccc2CC1C(=O)O)N1Cc2ccccc2CC1c1ccccc1,0.4494649227110582,1.0

11,CC(C(=O)N1Cc2ccccc2CC1C(=O)O)N1Cc2ccccc2CC1C(=O)O,0.4436183395291202,1.0

12,c1ccc(C2CC3CCCC3N2c2ccccc2)cc1,0.4426666666666666,1.0

(次のページに続く)
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(前のページからの続き)

13,COC(=O)[C@H](CC(C)C)NC1OC2OC3(C)CCC4C(C)CCC(C1C)C24OO3,0.43861607142857145,1.0

14,O=C(O)C1Cc2ccccc2CN1c1ccccc1,0.4348387096774193,1.0

15,CC1CCC2C(C)C(Nc3ccc(O)cc3)OC3OC4(C)CCC1C32OO4,0.4311717861205916,1.0

16,CO[C@@H](CC(C)C)C(=O)NC1OC2OC3(C)CCC4C(C)CCC(C1C)C24OO3,0.4242761692650334,1.0

17,CC(C(=O)Oc1ccccc1)N1C(c2ccccc2)CC2CCCC21,0.4230287859824781,1.0

18,CCOc1ccccc1C(=O)O,0.4228971962616822,1.0

19,Cc1cc(NC2CCNC2=O)no1,0.4113924050632911,1.0

短い smilesは無視する：

obabel -h -c -ican -:"CC(C(=O)N1Cc2ccccc2CC1C(=O)O)N1Cc2ccccc2CC1c1ccccc1" -opdbqt -O␣

↪→ligand.pdbqt --gen3D --partialcharge gasteiger

vina --config conf.txt

mode | affinity | dist from best mode

| (kcal/mol) | rmsd l.b.| rmsd u.b.

-----+------------+----------+----------

1 -8.417 0 0

2 -8.302 2.467 6.754

3 -8.003 4.96 7.503

4 -7.624 3.907 6.517

5 -7.506 5.171 7.983

6 -7.485 2.979 5.385

7 -7.433 5.416 9.353

8 -7.375 2.857 5.204

9 -7.296 2.998 5.526

類似性の目標となるターゲット分子そのものが必要な場合は、上記の方法が役立つかも知れない。

課題:

• MCTS solverを別パッケージにする

• ターゲット分子が無くともドッキング・シミュレーションで高得点を取れるシミュレーションは出来るか？

• Type boolが 1.0や 0.0のように csv fileに出力されてしまう。

• similarity-antは遅すぎて実用性に程遠い。

• そもそも similarity-mctsは正しく動作しているのか？

• Version 0.0.3の similarity-mctsはMCTS solverをインポートするので、この文書と出力が若干異なる。
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• 絡み合ったスパゲッティコードを解く。

5.4 参照

5.5 参考文献
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第 6章

Chem-Antプロジェクト - 創業メンバー募集

6.1 概要:

Chem-Antプロジェクトでは、治療薬候補の探索に革新的なアプローチを追求しています。現在、プロジェクトは
創業メンバーを募集しています。これは、rdkitと deapの genetic programming、そしてMCTS solverを組み合わ
せたシミュレーションのプロジェクトで、まだ会社は設立されていません。現在はプロジェクトリーダーである私

一人です。

6.2 募集ポジション:

• ソフトウェア開発者

• データサイエンティスト

• 化学情報学者

• マーケティング担当

• その他、プロジェクトに興味をお持ちの方

6.3 求めるスキル:

• Cheminformatics、Molecular Biology、または関連する分野の知識

• プログラミングスキル（Python等）

• チームワークとコミュニケーション能力
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6.4 応募方法:

ご興味をお持ちいただけましたら、git logにあるメールアドレスにご連絡ください。また、自己紹介やスキルセッ
トを添えていただけると幸いです。

6.5 注意:

Chem-Antはまだ設立されておらず、現在はプロジェクトとして進行中です。これは将来の企業設立に向けた先駆
的なプロジェクトであり、共に成長し、新たな治療薬開発のフロンティアに挑戦したい方を歓迎します。
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第 7章

索引

• genindex

• modindex

• search


	Chess-Ant 紹介
	準備
	使用法
	Chess-Classification

	Chess-Ant 論文
	AlphaZeroからの影響
	MCTS Solver
	並列処理
	変更履歴
	開発予定
	参照
	参考文献

	py-chessboardjs
	インストール方法
	使用法
	関連リンク

	Chem-Ant 紹介
	準備
	使用法
	Chem-Classification


